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Welcome 
This User Guide will help you install and use workstation-based components of 
SYSTRAN Enterprise Global Server 5.0. 

SYSTRAN Enterprise Global Server is the new marketing  name of SYSTRAN 
WebServer. Product features are strictly the same. Screenshots included in this 
manual can display the former name WebServer instead of Enterprise Global Server. 

About SYSTRAN Enterprise Global Server 5.0 
SYSTRAN Enterprise Global Server 5.0 is a client-server based application. The main 
application runs over your organization’s network, and is available over the network to 
you as a desktop user. Two user interface options –the SYSTRAN Enterprise Global 
Server 5.0 Online Tools and Application Packs – bring the power of SYSTRAN 
Enterprise Global Server 5.0 to your individual desktop workstation. 

SYSTRAN
Translation Server

`

Client PC
SYSTRAN Online Tools

SYSTRAN Application Packs

Corporate
Network

 

The tools included in SYSTRAN Enterprise Global Server 5.0 can be used with a wide 
variety of word processing, spreadsheet, email, and other software applications, and 
are designed to automate and enhance many of the steps in the translation process. 

SYSTRAN Online Tools 

SYSTRAN Online Tools provide a Web-based interface to the SYSTRAN Enterprise 
Global Server 5.0 application over your corporate network. 

SYSTRAN Application Packs 

SYSTRAN Enterprise Global Server 5.0 Application Packs are downloadable client 
software that provides you with access to translation capabilities through plugins in 
Microsoft Office applications (Word, Outlook, Excel, PowerPoint, Internet Explorer). 

These plugins allow you to access integrated tools such as a translator’s toolkit for 
post-editing and review, a robust dictionary manager and the ability to perform multiple 
translations in one operation. The Online Tools are installed on your client PC, and 
communicate with the SYSTRAN Translation Server over your standard network 
connection. 
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SYSTRAN User Tools 

SYSTRAN User Tools include the SYSTRAN Toolbar and SYSTRAN Clipboard 
Taskbar. 

The SYSTRAN Toolbar is automatically displayed in Microsoft Word, Excel, 
PowerPoint, Outlook, and Internet Explorer to support rapid and efficient 
translation of Office documents and Web pages in real-time. 

The SYSTRAN Clipboard Taskbar (SCT) lets you translate text from almost any 
Windows-based application not supported by the SYSTRAN Toolbar by cutting or 
copying text to the Windows Clipboard.  

SYSTRAN Expert Tools 

SYSTRAN Expert Tools provide additional flexibility in planning, managing and 
completing your translation projects. 

SYSTRAN Translation Project Manager (STPM) allows you to analyze and 
manage documents from the start of your project, through adding terms to the 
User Dictionary, processing dictionary updates, and using built-in review and 
regression tools for quality assurance. These tools include terminology review, 
analysis of the source (original) document, full sentence review, use of alternate 
meanings, and other features to automate the post-editing process. 

SYSTRAN Dictionary Manager (SDM) lets you create and maintain user-
defined dictionaries (User Dictionaries) that provide the software with greater 
understanding and coverage of your subject matter. The more terms added to 
the dictionaries, the higher the coverage of your terminology in the software - and 
higher coverage yields better quality translation results. 

SYSTRAN MultiTranslate Utility (SMTU) supports batch processing of multiple 
translation projects. 

Using this Guide 
This guide should be read by users of SYSTRAN Enterprise Global Server 5.0 who 
will install and use the SYSTRAN Enterprise Global Server 5.0 Online Tools and 
Application Packs. This guide assumes that you are familiar with the basic use of a 
Web browser (Internet Explorer, Netscape) and have a general understanding of the 
Windows Operating System. 

 The SYSTRAN Enterprise Global Server 5.0 Application Packs include the same 
tools as the SYSTRAN Professional Premium 5.0 desktop product. These 
features are described in greater detail in the SYSTRAN 5.0 User Guide, available 
online at: 

http://www.systransoft.com/support/UserGuide/index.html 

SYSTRAN Support 
For more information, contact SYSTRAN support at: 

http://www.systransoft.com/contact/Enterprise.html 



User Interface Guide: SYSTRAN Online Tools and Application Packs 7 

Chapter Overview 
Chapter Contents 

1. Welcome Overview of SYSTRAN Enterprise Global Server 5.0 
Online Tools, Application Packs, and how to use this 
Guide. 

2. SYSTRAN Enterprise 
Global Server 5.0 Online 
Translation Tools 

How to use the standard Web-based interface to translate 
files, Web pages, and text.  

3. SYSTRAN Enterprise 
Global Server 5.0 
Application Packs 

How to use the SYSTRAN Application Packs.  

• User Tools: SYSTRAN Toolbar and SYSTRAN 
Clipboard Taskbar. 

• Expert Tools: SYSTRAN Translation Project 
Manager, SYSTRAN Dictionary Manager, and 
SYSTRAN MultiTranslate Utility. 

Appendix A: Glossary A Glossary of terms used in this Guide and in SYSTRAN 
Enterprise Global Server 5.0. 

Appendix B: Language Pairs A list of the language pairs available in SYSTRAN 
Enterprise Global Server 5.0. 

Appendix C: Installing the 
Application Packs 

How to install the User Tool and Expert Tool Application 
Packs. 

Typographic Conventions 
The following symbols and typeface conventions are used in this Guide. 

Tips 

A tip provides helpful information. The  icon identifies a tip. 

Notes 

A note is information that requires special attention. The  icon identifies a note. 

Cautions 

A caution contains information that, if not followed, can cause damage to the 
application or critical files in the application or to the user's computer.  
The  icon identifies a caution. 

Menu, Command, and Button Names 

The names of menus, commands, and Toolbar buttons are shown in a Bold typeface. 

Filenames and Items You Type 

Filenames and items that you type are shown in a Courier typeface. 
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About SYSTRAN 
SYSTRAN offers the most widely used Language Translation Software in the world 
covering desktop products, scalable client-server applications (customer-hosted) and 
online services (SYSTRAN hosted). Our core language translation technologies power 
innovative products and solutions for PCs, networks and the Internet that facilitate 
communication in 40 language combinations and in 20 specialized domains. 

SYSTRAN’s enterprise solutions enable the creation of multilingual content for 
businesses to manage large amounts of information in a consistent manner. They are 
applied across diverse best-practice solutions for intra-company communications, 
content management, online customer support, eCommerce, email systems, chat, and 
more. The choice of leading search engines, global corporations and governments, 
SYSTRAN solutions increase user productivity levels and time-savings and have been 
doing so for over three decades. 

 



 

Chapter 2: 
SYSTRAN Enterprise Global Server 5.0 

Online Translation Tools 
Using the Online Tools 

Web Page Translation 

File Translation 

Text Translation 

Selecting a Dictionary 

Selecting Translation Options 

Offline Tasks 

Troubleshooting Online Tools 
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SYSTRAN Enterprise Global Server 5.0 Online 
Translation Tools 

The SYSTRAN Enterprise Global Server 5.0 Online Tools interface is available on 
your desktop PC once your organization has installed SYSTRAN Enterprise Global 
Server 5.0 on the corporate server. You can use the Online Tools to translate from an 
original (source) language into a different (target) language. 

This interface allows you to easily translate: 

• Web pages 

• Files (TXT, RTF, DOC, PDF, XML, or HTML) 

• Text (any text that you can select in a Windows-based application) 

These functions are available to all users on your network through a standard Web 
browser (Internet Explorer, Netscape, etc.). 

Dictionaries and Translation Options 

The SYSTRAN Enterprise Global Server 5.0 Online Tools allow you to improve the 
quality of your translations by using Dictionaries.  

• Five built-in SYSTRAN Dictionaries are available, containing terms associated 
with industry, business, life sciences, colloquial usage and sciences. 

• You can create User Dictionaries (UDs) of industry and company-specific terms 
to further improve your translation results. User Dictionaries are one of the most 
powerful resources for your translation projects. 

• Translation Memory (TM) stores and recycles previously translated units of text – 
like sentences – in bilingual databases, and is commonly used to increase 
productivity by automatically searching for and replacing previously translated 
sentences. 

• Normalization Dictionaries (NDs) provide a way to normalize text before or after 
translation (“4u” can be defined as “for you”). You can also use NDs to 
standardize spellings (“online” instead of “on-line”), or to establish common 
terminology (when two words are used for the same concept). 

  Dictionaries can be created and managed using SYSTRAN Dictionary Manager 
(SDM). See page 39 for more information. 

SYSTRAN Enterprise Global Server 5.0 Translation Options include Sentence 
Review, Alternative Meanings, and other tools designed to improve the quality of your 
translations. 



User Interface Guide: SYSTRAN Online Tools and Application Packs 11 

Using the Online Tools 
If you are using the Online Tools, all translations begin through the main screen. 
The screen is organized in five steps: 

 

 

  Step 2 will change based on the type of content you are translating: a file, Web 
page or text. Steps 3, 4, and 5 will be the same for all three types of content. 

1. Choose a 
language pair 

2. Choose the type of 
content to be 
translated 

3. Select Dictionaries 
to use 

4. Select Translation 
Options to use 

5. Translate the 
content 
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Web Page Translation 

 

1. Use the Translate from drop-down list to select a language pair for the 
translation. A list of the available language pairs can be found in Appendix B. 

2. Click the A Web page radio button. 

3. Enter a URL location. 

 You can copy and paste the URL into the address box. To do this, open a 
second browser window and go to the Web page that you want to 
translate. 

Select the URL in the address field at the top of the browser window. 
Copy it (Ctrl+C) and then return to the SYSTRAN Enterprise Global 
Server 5.0 window. Paste the URL into the address field. 

4. Select your Dictionaries (see page 16). 

5. Select Translation Options (see page 17). 

6. Click Translate. The translated Web page is displayed in the SYSTRAN 
window. 

Enter URL 
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File Translation 

SYSTRAN Online Tools can automatically translate TXT, RTF, DOC, PDF, XML or 
HTML files, and will preserve the original document’s formatting in the translated 
version. 

 

 

1. Use the Translate from drop-down list to select a language pair for the 
translation. A list of the available language pairs can be found in Appendix B. 

2. Click the A File radio button. 

3. Enter a file location and name, or click Browse… to locate the file. 

4. Select your Dictionaries (see page 16). 

5. Select Translation Options (see page 17). 

6. Click Translate. SYSTRAN Enterprise Global Server 5.0 will prompt you to 
View, Save, or Cancel the translation. 

 

Open Display the file in the application (Word, Excel, PowerPoint, etc.) 

Save Open a Windows Save dialog box to name and save the file. 

Cancel Cancel the translation. 

 

Enter File name 
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Text Translation 

Use this option to translate any text that is not in a TXT, RTF, DOC, PDF, XML or 
HTML file. You can select text from any Windows-based application and translate it. 

 

1. Use the Translate from drop-down list to select a language pair for the 
translation. A list of the available language pairs can be found in Appendix B. 

  The availability of language pairs depends on your server license. 

2. Click the Type or paste in text below radio button. 

3. Type the text to be translated into the open field, or cut/copy the text from 
another application and paste it into the field. 

4. Select your Dictionaries (see page 16). 

5. Select Translation Options (see page 17). 

6. Click Translate. The translated text will display at the bottom of the screen. 

Enter or paste 
source text here 

Translated text 
appears here  
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7. Use the Printable form drop-down list to select a display option for the 
translated text. 

Bilingual Printable form displays the source and translated text side by side. 

 

Monolingual Printable form displays only the translated text. 
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Selecting a Dictionary 

You can select SYSTRAN Dictionaries, User Dictionaries (UDs), Translation 
Memories (TMs) and Normalization Dictionaries (NDs) to customize and improve your 
translations. The User Dictionaries available in your installation of SYSTRAN 
Enterprise Global Server 5.0 are determined by your Network Administrator. 

  Dictionaries can be created and managed using SYSTRAN Dictionary Manager 
(SDM). See page 39 for more information. 

1. Click Select your dictionaries to display the Dictionary Preferences dialog box. 

 

2. Click the checkboxes to select one or more SYSTRAN dictionaries. 

3. Click the arrows to set the order of priority for SYSTRAN Enterprise 
Global Server 5.0 to use when checking the source text against the 
dictionaries. 

4. Select any number of Domains to use. Click the arrows to set the order 
of priority for SYSTRAN Enterprise Global Server 5.0 to use when checking 
the source text against the Domains. 

5. Click Submit to save your dictionary preferences. To close the Dictionary 
Preference window, click Close. 

  When you click Submit, your dictionary settings will be saved for the type of 
content you are translating (Web page, file, or text). These settings will be used 
the next time that you want to translate this type of content. However, these 
settings will be erased when you delete the cookies from your browser. Contact 
your Network Administrator for more information about cookies. 
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Selecting Translation Options 
SYSTRAN Enterprise Global Server 5.0 allows you to set formatting, linguistic, and 
grammatical options for each type of translation (Web page, file or text). 

1. Click Select your translation options to display the Translation Options 
dialog box. 

 

 

  Translation options depend on the source and target language. Place your cursor 
over a Translation Option to see a brief description. 

2. Click Submit to save your Translation Options preferences. To close the 
Translation Options window, click Close. 

  When you click Submit, your Translation Options settings will be saved for the 
type of content you are translating (Web page, file, or text). These settings will be 
used the next time that you want to translate this type of content. However, these 
settings will be erased whenever you delete the cookies from your browser. 
Contact your Network Administrator for more information about cookies. 
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Offline Tasks and Translation Results page 

Some translation requests can be completed within a few seconds. Longer documents 
or more complex requests will require more time and are therefore completed as 
offline tasks. 

Offline tasks are listed on the Translation Results page. 

For each translation, a progress bar showing the status of a translation is displayed.  
When a translation is in progress, a percentage of the task has been completed is 
displayed. 

 

• Click Cancel to remove a task from the list before the translation is completed. 

• Click View to display the current status of a task. If the task is already completed, 
clicking View displays the results of the translation.  

• Click Delete to allow the user to remove the result. 

• Click Start a new translation to return to the translation page and launch a new 
translation. 



User Interface Guide: SYSTRAN Online Tools and Application Packs 19 

 

To return to the Translation Results page when offline tasks are in progress, click on 
Click here to view results from your previous translation requests for a status 
update of previous translation requests. 

Troubleshooting Online Tools 

Contact your Network Administrator if you have problems completing a translation 
using the SYSTRAN Enterprise Global Server 5.0 Online Tools. 

 



 

Chapter 3: 
SYSTRAN Enterprise Global Server 5.0 

Application Packs 
Application Pack Options 

SYSTRAN User Tools 

SYSTRAN Expert Tools 

Working with the User Tools 

Using the SYSTRAN Toolbar 

Using the SYSTRAN Clipboard Taskbar 

Working with the Expert Tools 

Using SYSTRAN Translation Project Manager (STPM) 

Using SYSTRAN Dictionary Manager (SDM) 

Using SYSTRAN MultiTranslate Utility (SMTU) 

Troubleshooting Application Packs 



User Interface Guide: SYSTRAN Online Tools and Application Packs 21 

SYSTRAN Enterprise Global Server 5.0 
Application Packs 

Application Pack Options 
SYSTRAN Enterprise Global Server 5.0 Application Packs (User Tools and Expert 
Tools) can be downloaded and installed on your desktop PC. Each Application Pack 
contains client software that can be used to perform translation tasks in conjunction 
with the Enterprise Global Server level software installed on the server.  

  You will need administrator permission to download the Application Packs. 
Contact your Network Administrator. 

SYSTRAN User Tools 

SYSTRAN User Tools include the SYSTRAN Toolbar and SYSTRAN Clipboard 
Taskbar. 

The SYSTRAN Toolbar is automatically displayed as a toolbar in Microsoft 
Word, Excel, PowerPoint, Outlook, and Internet Explorer, providing one point of 
access to powerful translation capability from inside these applications. 

 

You can use the Toolbar to translate from an original (source) language into a 
different (target) language. The SYSTRAN Toolbar also provides one-button 
access to User Dictionaries and other tools you can use to modify and improve 
the quality of your translation. 

The SYSTRAN Clipboard Taskbar (SCT) lets you translate text from almost any 
Windows-based application not supported by the SYSTRAN Toolbar by cutting or 
copying text to the Windows Clipboard. SCT automatically translates the Clipboard 
text, which you can then paste into any Windows-based application. 

 

The SCT appears at the top of your screen, with your Windows-based application 
below it, allowing easy access to the translation capability of SYTRAN Enterprise 
Global Server 5.0. 
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SYSTRAN Expert Tools 

SYSTRAN Expert Tools provide robust capability for planning, managing and 
completing your translation projects, and for improving the quality of your results with 
each new project you complete. 

SYSTRAN Translation Project Manager (STPM) helps you work with, edit, and 
enhance your translations. You can define options, review terminology, use 
Translation Memory, and interact with the SYSTRAN Dictionary Manager to build 
and modify your translation dictionaries. Powerful tools are also built into this 
application to support your regression testing and QA efforts. 

SYSTRAN Dictionary Manager (SDM) lets you build, create, and maintain User 
Dictionaries (UDs), Translation Memories (TMs), and Normalization Dictionaries 
(NDs), which can be used to customize your translations to your unique 
terminology and requirements. 

SYSTRAN MultiTranslate Utility (SMTU) is designed for users who perform a 
large number of translations. Using SMTU, you can place documents into groups 
(or batches) and translate them in one operation. 

  This section of the User Guide will provide a general overview of use of the 
Application Packs. 

• For Application Pack installation, refer to Appendix C. 

• For more information on use of the SYSTRAN Toolbar, SCT, STPM, SDM 
and SMTU, refer to the SYSTRAN 5.0 User Guide. 

Working with the User Tools 

Using the SYSTRAN Toolbar 

Once the SYSTRAN Toolbar is installed on your PC, it will appear at the top of the 
screen in any standard Microsoft Office application (Word, Excel, PowerPoint, Outlook 
and Internet Explorer). 

 

 

 

 

 

 

Help 

Review 
User Dictionaries

Translation Options 

Translate 
Language Pair 
drop-down list 

Plugin Options  
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To use the SYSTRAN Toolbar: 

1. Open a file in Word, Excel, PowerPoint, Outlook or Internet Explorer. The 
Toolbar will appear on the Office toolbar. 

2. Select a Language Pair from the drop-down list. 

3. Click the Dictionaries button to use dictionaries to improve the quality of 
your translation. You can then select from the SYSTRAN Dictionaries, User 
Dictionaries (UDs), Translation Memories (TMs), and Normalization 
Dictionaries (NDs) available on your network server. The dictionaries listed in 
the window depend on the Office application and the source and target 
languages you select. Scroll down as required to view the full range of 
available dictionary options. 

 

• Check each SYSTRAN Dictionary, UD, TM, and/or ND that you want to use. 
Each time you click a dictionary, the Domains associated with it appear in the 
Available Domains pane.  

• Set the priority for using each dictionary resource by clicking the arrows to 
the right of each dictionary. The selected dictionary will move higher or lower in 
the priority sequence. 
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  UDs, TMs and NDs take priority over the SYSTRAN Dictionaries during the 
translation process. 

• The available domains for each Dictionary resource selected will appear in the 
bottom pane. Check each Domain that you want to use with your translations. 
Then, set the priority for each selected Domain by clicking the arrows to 
move it higher or lower in the priority sequence. 

 

3. To use Translation Options to improve the quality of your translation, click the 
Translation Options button. The Translation Options dialog box lists the 
available options. Place your mouse cursor over a Translation Option to see 
a definition of its function. 
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4. Click Translate to perform the translation. 

5. Repeat steps 3 and 4 as required to improve the quality of your translation. 
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Using the SYSTRAN Clipboard Taskbar 

SYSTRAN Clipboard Taskbar (SCT) lets you translate text from almost any Windows–
based application by cutting or copying it to the Windows clipboard. SCT automatically 
translates the clipboard text, which you can then paste into your application. 

 

 

 

 

 

 

 

1. Open a file in any Windows-based program. 

2. Click on the SYSTRAN Clipboard Taskbar desktop icon or go to Start, 
Programs, SYSTRAN program group, and then click on SYSTRAN 
Clipboard Taskbar. 

3. Highlight the text that you want to translate. 

4. Copy the text to the Windows clipboard. 

5. Select the source and target languages on the SYSTRAN Clipboard Taskbar. 

6. Click the Dictionaries button to use dictionaries to improve your translation. 

7. To use Translation Options to improve your translation, click the Translation 
Options button. 

8. Click Translate on the SYSTRAN Clipboard Taskbar. 

  This step is not necessary if you have set the Active Clipboard to Yes in the 
Clipboard Translation Options panel:  

9. The progress bar on the right side of the Taskbar indicates the status of the 
translation. When the translation is done, paste the translated text into your 
target application. 

  To paste translated text into an application other than the one you copied it 
from – such as copying text from a Web browser, translating the text, and 
pasting it into a text editor – you may need to enable Cross-Application 
Support in the Clipboard Translation Options panel:  

Help 

User Dictionaries

Translation Options 

Source 
Language 

Target 
Language 

Clipboard Translator 
Options 

Translate

Exit
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Working with the Expert Tools 
The SYSTRAN Expert Tools – SYSTRAN Translation Project Manager (STPM), 
SYSTRAN Dictionary Manager (SDM), and SYSTRAN MultiTranslate Utility (SMTU) – 
are available to users with access to the application Downloads Web page. See your 
Network Administrator if you need to receive this level of access. 

Using SYSTRAN Translation Project Manager (STPM) 

SYSTRAN Translation Project Manager (STPM) provides a set of powerful tools for 
editing and improving the quality of your translations and automating the post-editing 
process. 

You can import DOC, RTF, TXT, HTML, XHTML and TMX-formatted files into STPM, 
translate them, and then compare the original (source) and translated (target) 
documents side-by-side. You can then post-edit to customize the translation. STPM 
also interacts with SYSTRAN's full range of dictionary resources to integrate post-
edited terms and phrases into Translation Memory and User Dictionaries. 

Starting STPM 

To launch STPM, click the SYSTRAN Translation Project Manager icon on your 
desktop, or click Start, Programs, SYSTRAN 5.0, SYSTRAN Translation Project 
Manager. The SYSTRAN Translation Project Manager window displays. 

 

 

 

 

 

Stop 

Web Toolbar 

Progress Bar Status Bar

Main screen area 
 
Source and Target 
windows appear here 

SYSTRAN
Toolbar 

Format
Toolbar

Standard
Toolbar 

Menu Bar 



28 User Interface Guide: SYSTRAN Online Tools and Application Packs 

 

 
Screen Item Description 

Menu Bar Contains the STPM menus. Each menu has a list of 
commands to perform various STPM activities. 

Standard Toolbar Buttons for commonly used STPM commands. 

Format Toolbar A drop-down list for selecting fonts and formatting. 

Web Toolbar Lets you enter Web page addresses (URLs). 

Stop Stops the current action. 

SYSTRAN Toolbar Lets you select source and target languages, choose 
Dictionaries and Translation Options, and perform 
translations. 

Main Area The area where the source and target windows appear. 

Status Bar Displays project status messages. 

Progress Bar Shows the progress of the translation. 

 

Managing Files, Web Pages, and Projects 

Files are imported into STPM using Import File on the File menu, while Web pages 
are accessed using STPM’s Web Toolbar.  

When you import a file or display a Web page, STPM automatically creates a project. 
A project contains a source document and a target document, with each document 
appearing in its own window in the main area of the STPM screen. 

The first step in using STPM is to import a file or display the Web page that you want 
to translate. 

Opening an Existing Project 

To open an existing STPM project: 

1. On the File menu, click Open Project, or click the Open Project button. 

2. Select a file to open. 
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Importing a File (New Project) 

To import DOC, RTF, TXT, HTML, XHTML and TMX-formatted files: 

1. On the File menu, click Import File. The Open dialog box appears. 

 

2. Select a file and click Open. STPM creates a new project and displays the 
selected file in the source document window. 

 

Source document 
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Translating the file 

1. When the file is open in the STPM window, click Translate. The translated 
document or Web page appears in the target document window. 

 

 

 

Displaying a Web Page (New Project) 

To display a Web page: 

1. Enter the Web address (URL) of the Web page that you want to translate in 
the Address field of the Web Toolbar: 

 

2. Click the Open button to the right of the Address field. STPM creates a new 
project and displays the Web page in the source document window 

Source document Translated document 



User Interface Guide: SYSTRAN Online Tools and Application Packs 31 

 

Translating the Web page 

2. When the Web page is open in the STPM window, click Translate. The 
translated document or Web page appears in the target document window. 

 

 

Source Web page 

Source Web page Translated Web page 
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Using Alignment 

STPM Alignment lets you select a sentence in either the source or target window and 
view the corresponding sentence in the other document or Web page. This helps you 
identify areas where you may want to improve the quality of the translation. 

Using the Review Functions 

Click  to open the Review dialog box, which has tabs for advanced functions to 
help improve the quality of your translation. Click a tab to access one of these 
functions. 
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Selecting Alternative Meanings 

The Alternative Meanings tab shows alternative meanings for expressions in 
SYSTRAN or User Dictionaries. This tab is helps you choose the preferred translation 
when several choices are offered by the software. 

 

1. Click the Alternative Meanings tab. 

2. Review the choices on each line. To select a choice, click the radio button in 
front of it. 

3. If you want the software to always handle a choice as shown in the 
Alternative Meanings tab, click the checkbox in the left column. 

4. Click Translate on the SYSTRAN Toolbar to apply your selections to the 
translation. 
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Selecting a Translation Memory 

The Translation Memory tab shows sentences for which a Translation Memory has 
been applied. You can compare the software-generated translation with Translation 
Memory entries and decide which entry should be used. 

 

1. Click the Translation Memory tab. 

2. Review the choices on each line. To select a choice, click the radio button in 
front of it. 

3. If you want the software to always handle a choice as shown in the 
Translation Memory tab, click the checkbox in the left column. 

4. Click the Translate button on the SYSTRAN Toolbar to apply your selections 
to the translation. 
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Modifying Source Analysis 

 

The Source Analysis tab shows how the software handled source ambiguities and 
allows you to override the selections. 

1. Click the Source Analysis tab. 

2. Review the choices on each line. To select a choice, click the radio button in 
front of it. 

3. If you want the software to always handle a choice as shown in the Source 
Analysis tab, click the checkbox in the left column. 

4. Click the Translate button on the SYSTRAN Toolbar to apply your selections 
to the translation. 
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Reviewing Terminology 

The Terminology Review tab lets you identify expressions such as Not Found Words 
or Terminology Extraction that the software found. These terms can then be added to 
the User Dictionaries. 

 

To use this tab to add new terms and expressions to User Dictionaries: 

1. Click the Terminology Review tab. 

2. Review the Not Found Words (NFW) and Extracted Terminology. Check 
the box to the left of each term you would like to add to a User Dictionary. 

  The Terminology Extraction option should be set to Yes in the 
Translation Options pane. 

3. Click Send to SDM to send the checked terms to the appropriate UD. 

4. When the Save As dialog box appears, select a filename and click Save. You 
can then use SDM to work with the terms to improve your translation results. 

5. Click the Translate button on the SYSTRAN Toolbar to apply your selections 
to the translation. 
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Reviewing Sentences 

The Sentence Review tab lets you compare sentences in the source and target 
windows. You can then send selected sentences to Translation Memory. 

 

1. Click the Sentence Review tab. 

2. Review the sentences. To send a sentence to a Translation Memory (TM), 
click the checkbox to the left of the sentence. 

3. Click Send to SDM to send the checked sentences to the appropriate TM. 

4. When the Save As dialog box appears, select a filename and click Save. You 
can then use SDM to work with the sentences to improve your translation 
results. 

5. Click the Translate button on the SYSTRAN Toolbar to apply your selections 
to the translation. 
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Searching and Highlighting 

STPM Search and Highlight lets you view particular words and expressions such as 
extracted terminology, Not Found Words, words with alternative meanings, and words 
with source ambiguities. By identifying these words, you can then take steps to 
improve the quality of your translations. 

Expressions are color-coded to make them easy to locate. The Search and Highlight 
window also provides buttons to view all instances of an expression or locate them 
one at a time. 

To search and highlight words: 

1. Click Search and Highlight on the 
SYSTRAN Toolbar. The Search and 
Highlight dialog box appears. The left 
column shows the color used to identify 
the expression. 

2. To locate a particular word, type it in the 
Word Search field. Then, select all 
instances or next instance of the word. 

  Word Search is performed in the currently 
selected document (source or target). 
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Other STPM tasks 

You can perform the following additional tasks in STPM. These tasks are described in 
detail in the SYSTRAN 5.0 User Guide. 

• Perform contextual dictionary activities. 

• Set Do Not Translate (DNT) blocks. 

• Find expressions in User Dictionaries.  

• Edit and format text. 

• Navigate between projects in the SYSTRAN Translation Project Manager 
window. 

• Save projects. 

• Export projects, source files and Web pages, and target files and Web pages. 

Using SYSTRAN Dictionary Manager (SDM) 

The SYSTRAN Dictionary Manager (SDM) allows you to prioritize your use of the 
SYSTRAN Dictionaries, and to create and manage the User Dictionaries, Translation 
Memories and Normalization Dictionaries. 

  These dictionary resources are maintained on your organization’s server. User 
Dictionaries, Translation Memory and Normalization Dictionaries may be created 
on your PC and then uploaded to the server for use. 

Dictionary Access Permission 

Four levels of permission for managing dictionaries can be assigned by your Network 
Administrator. 

Upload Upload any user-defined dictionaries (UDs, TMs, NDs) to the server 

Compile Compile user-defined dictionaries (UDs, TMs, NDs) 

Publish Make user-defined dictionaries (UDs, TMs, NDs) available for public use 

Share Publish and edit shared dictionaries (UDs, TMs, NDs) 

Creating User Dictionaries 

Users with Upload and Compile permission can add new User Dictionaries (UDs) to 
the resources on the server. 

UDs let you train the software by adding or editing terms to be considered during 
translations. UDs can include terms that have specific or unique meanings, such as 
your company name, or terms specific to your business or industry that are not 
included in the built-in SYSTRAN Dictionaries or Domains. The more UDs you 
create, the more you enhance the software’s understanding of the material you 
are translating. 
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 The following procedure provides basic instructions for creating a User Dictionary 
with SDM. For more information about UDs and SDM, refer to the SYSTRAN 5.0 
User Guide. 

1. Click Start, Programs, SYSTRAN program group, SYSTRAN Dictionary 
Manager. 

2. On the File menu, click New, and then click Dictionary Project. 

 

3. Select a Source language by clicking the drop-down list. 

4. Select a Target language in the Available languages list. Click  to add the 
selected language to the Visible columns box in the Target language list. To 
remove a language from the list, select a language and click . 

5. Check Show coding status checkbox to view whether the coding for an 
entry is successful. 

6. Click the Properties tab. 
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7. Define the name that will be displayed when selecting the dictionary for a 
translation in the corresponding textbox. 

8. Click OK. 

9. From the Edit menu, click Add Entry. In the left column, type the word or 
phrase for the source language. Move the cursor to the Target language field 
and enter the appropriate word or phrase in the target language. 

 

10. Repeat step 9 to add more words and phrases. 

11. When you finish adding words and phrases, click Save on the File menu and 
assign a name to the UD. Click Save. Your new User Dictionary is now 
available for use in any SYSTRAN application. 
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Creating Dictionaries in other applications 

Dictionaries can also be created in Excel or text editors and then uploaded and 
compiled using the Dictionary Compilation page. 

1. Create the dictionary in Excel or another compatible application. Refer to 
the SYSTRAN 5.0 User Guide for more information about creating the 
dictionary file. 

2. Open the Dictionary Compilation dialog box. 

 

 

3. Enter a name for the dictionary in the Dictionary display name field. This 
name will appear in the User Dictionary list in all SYSTRAN applications. 

4. Enter the name of the file to upload in the Upload a new source file field or 
click Browse to select the file. 

5. Click Submit to upload the new dictionary to the Translation Server. 
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Shared and Public Dictionaries 

When a dictionary is first uploaded, it is only available to the user who created it. For 
other users to see the dictionary, it must be set as Shared or Public (or both) using 
the SYSTRAN Dictionary Manager. 

 

To make a dictionary available for use by others, set the Public attribute of the 
dictionary to Yes. 

It is also possible for several users to collaborate in the development of a dictionary. 
To allow this, set the Shared attribute of the dictionary to Yes and make sure that 
each of the collaborating users has been granted the Share permission. These other 
users can then modify and use the shared dictionary. 

 The Shared attribute provides permission for more than one user to modify a 
dictionary. It does not provide protection against overwriting changes made by 
another user who is editing the dictionary at the same time. 
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Using SYSTRAN MultiTranslate Utility (SMTU) 

SYSTRAN MultiTranslate Utility (SMTU) allows you to translate groups (or batches) of 
documents at one time. 

1. Click Start, Programs, SYSTRAN program group, and then click on 
SYSTRAN MultiTranslate Utility. 

2. To create a new batch project, click New Project on the File menu. 

 

6. Add the files, folders, and Web pages that you want to translate. Click  to 
add a single file. Click  to add an entire folder. 

7. Place the files in the Batch Contents list in the desired sequence using the 
 arrows. 

 

8. Select a source and target languages in the SYSTRAN Toolbar. 

9. Use the Batch Entry Options panel to specify destination file locations for 
the translated files, as well as other processing options:  
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10. Click the Translate button and click Translate Batch to translate all the 
documents that you added to the batch project. 

11. Save the project by clicking Save Project on the File menu. You can reopen 
your file by clicking Open Project on the File menu. 

 

Troubleshooting Application Packs 
Contact your Network Administrator if you have problems completing a translation 
using the SYSTRAN Enterprise Global Server 5.0 Application Packs. 

 



 

Appendix A: Glossary 
 

Term Definition 

A  
Acronym In SYSTRAN terminology, a word, all uppercase, formed from the initial letters of 

other words or parts of a series of words, such as WAC for Women's Army Corps.

Adjective A word used to modify a noun by limiting or qualifying. In English, it can be 
distinguished by one of several suffixes, such as -able, -ous, -er, and -est, 
because it directly precedes a noun or noun phrase, such as red in a red door, 
or because it is preceded by a form of to be, such as the door is red. 

Adverb A word that modifies a verb, an adjective, or another adverb, such as brightly in 
The sun shines brightly. 

Algorithm A step-by-step problem-solving procedure. 
Article A word used to signal a noun and to specify its application. In English, the 

definite article is the, and the indefinite articles are a and an. 
Auxiliary verb A verb, such as have, can, or will, that accompanies the main verb in a clause 

and helps to make distinctions in aspect, mood, tense, and voice. 

C  

Clause A group of two or more words which contains a verb. One or more clauses make 
up a complete sentence. 

D  

DNT An acronym for Do Not Translate. 

DNT List A list of words created by the translator that will not be translated by the 
SYSTRAN Translation Software. 

Do Not Translate A sequence of words (part of a sentence) that is not to be translated. 

Do Not Translate 
(DNT) Insertion 

A sequence of words within a complete sentence that is not to be translated. 

Do Not Translate 
(DNT) Paragraph 

A part of a document that is not to be translated. 

E  

Embedded clause A subordinate clause that is embedded in the middle of a main clause. For 
example, The camera, which I bought yesterday, is already broken. 

Expression In SYSTRAN terminology, a noun phrase consisting of more than one noun or 
any combination of nouns and adjectives, where the Headword is a noun, such 
as lug nut, Library of Congress, and red-letter day. Complete sentences are not 
valid SYSTRAN expressions; neither are any phrases that contain verbs. 

Expression Dictionary The SYSTRAN dictionary that contains expressions. See Stem Dictionary. 

F  

Finite verb A verb form that is limited in tense, person, and number, such as goes in He 
goes. 

First person A pronoun that refers to the speaker. For example, I in I see, or We in We are. 
Also, a verb form that refers to the speaker. For example, am in I am, or are in 
We are. Verb inflection rarely indicates person in English, but in other 
languages, it often does. 
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Term Definition 

 
H 

 

Headword In SYSTRAN terminology, the noun in a noun phrase that can change when 
plural, such as nut in lug nut, Library in Library of Congress, and day in red letter 
day. 

Homograph In SYSTRAN terminology, one of two or more words that have the same spelling 
and are different parts of speech (for example, noun and verb, or adjective and 
verb). For example, head as in head west or on the head, and light, as in the 
light box and light the match. 

I  

Imperative A verb form that is used to express an order or command. For example, Eat in 
Eat your vegetables. 

Infinitive A verb form that is the ordinary dictionary-entry form. In English, it is often used 
with to as in He wants to eat. It may also occur without to, for example, get in I 
made them get in line, or with auxiliary verbs such as must as in We must leave. 

Inflection An alternation of the form of a word by adding suffixes without changing the 
basic meaning or part of speech, as in making rugs from rug, or by changing the 
form of a base word, as in making ate from eat. 

M  

Main clause A clause that can stand alone as a complete and correct sentence. For example, 
It was raining. 

N  

NFW The acronym for Not-Found Word. 

Not-Found Word A word or string that occurred in the text, but not in the dictionaries used in 
translation. 

Not-Found Word List An alphabetical list of all words in a text that were not found in the dictionaries 
used for translation. 

Not-Found Word 
Marker 

A mark that the translator can select, which appears in the translation to 
indicate a Not-Found Word. 

Noun A word that is used to name a person, place, thing, quality, or action, for 
example, house, flammability, or movement. 

Noun phrase A phrase that functions as a noun, and that has a noun as its Headword. 

P  

Parse To break (a sentence) down into its component parts of speech with an 
explanation of the form, function, and syntactical relationship of each part. 

Parser In SYSTRAN terminology, the module of the software that performs syntactic or 
semantic analysis of the Source text. 

Participle A verb form that can be used with an auxiliary verb. It can also function as an 
adjective or a noun. See Past Participle and Present Participle. 

Past participle A verb form that indicates past or completed action. It can be used with an 
auxiliary verb as in The cake was baked yesterday, or as an adjective, as in 
baked beans. 

Phrase A sequence of two or more words which express an idea. See also, Noun 
Phrase, Verb Phrase, and Prepositional Phrase.  

Plugin A software component that adds a specific feature or service to a larger 
application. For example, SYSTRAN 5.0 provides plugins for performing 
translations from Internet Explorer and the following Microsoft Office 2003, XP, 
and 2000 applications: Word, Excel, PowerPoint, and Outlook. 
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Term Definition 
 
POS 

 
The acronym for Part of Speech. 

Preposition A word placed before a noun or noun phrase, indicating the relation of that noun 
or noun phrase to a verb, an adjective, or another noun or noun phrase, such as 
at, by, in, to, from, and with. 

Prepositional phrase A phrase that consists of a preposition plus the noun or noun phrase that it 
governs, such as at the park, in reference to your letter, or from Mars. 

Present participle A verb form expressing present action, formed in English from the infinitive plus 
-ing, which can be used with auxiliary verbs as in He is baking a cake; as an 
adjective, the baking rack; or as a noun, as in, the act of baking. 

Principal Word The main word in an expression. For example, clip in paper clip. The Principal 
Word is not necessarily the same as the Headword. In the expression paper clip 
box, clip is the Principal Word, but box is the Headword. 

Pronoun A word that functions as a substitute for a noun or a noun phrase and 
designates persons or things asked for, previously specified, or understood from 
the context. For example, I, it, that, and which. 

Proper noun A noun belonging to the class of words used as names for individuals or places. 
For example, Clinton or Boston. 

S  

Second person A pronoun that refers to the listener. For example, you in You see or You are. 
Also, a verb form that refers to the listener. For example, are in You are. Verb 
inflection rarely indicates person in English, but in other languages, it often 
does. 

Semantic Having to do with meaning. 

Sentence A grammatical unit that is syntactically independent and has a subject that is 
expressed or understood and a predicate that contains at least one finite verb. 

Source The language of the original text, before translation. 

Specialized 
Dictionary 

A translation option that allows the translator to choose appropriate subject 
areas for the document. 

Stem Dictionary The SYSTRAN dictionary that contains all forms of single words. See Expression 
Dictionary.  

Subjunctive A verb form that indicates possibility, doubt, or desire rather than fact. For 
example, “were” in I wish it were true, or “start” in I suggest you start 
immediately. 

Subordinate clause A clause that modifies or expands on other clauses. A subordinate clause 
modifies or expands on another clause. It cannot stand alone, as that he gave 
in The account that he gave was true. 

Subordinate clause 
marker 

A word that indicates a clause is a subordinate clause, such as that, which, or 
who. 

Subordinate phrase A phrase that modifies or expands on other phrases. 

Syntactic Having to do with sentence structure. 

T  

Target The language into which the text is translated. 

Third person A pronoun that refers to neither the speaker nor the listener. For example, He in 
He is, She in She is, it in it is, or They in They are. Also, a verb form that refers to 
neither the speaker nor the listener. For example, is in He is and She is, or are 
in They are. Verb inflection rarely indicates person in English, but in other 
languages, it often does. 
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Term Definition 
 
Translation Memory 
(TM) 

 
Translation Memory stores and recycles previously translated units of text – like 
sentences that can be integrated into the translation process  

U  

UD The acronym for User Dictionary. 

User Dictionary A dictionary used in translation that has been created by the user for the 
purpose of tailoring translations to his specific needs. Definitions in a UD 
override the ones in the SYSTRAN dictionaries. 

V  

Verb A word that expresses existence, action, or occurrence. 

Verb phrase In SYSTRAN terminology, a phrase or other construction used as a verb. Verb 
phrases are not acceptable entries in a UD. 

Verb-noun 
homograph 

In SYSTRAN terminology, a word that has a verb usage, such as the word work 
in I work all day and a noun usage, such as the word work in Work is fun. 

 



 

Appendix B: Language Pairs 
SYSTRAN Enterprise Global Server 5.0 supports the following 40 language pairs: 

English ↔ Spanish 

English ↔ German 

English ↔ Italian 

English ↔ Portuguese 

English ↔ Dutch 

English ↔ Greek 

English ↔ French 

English ↔ Swedish 

English ↔ Japanese 

English ↔ Korean 

French ↔ Spanish  

French ↔ German  

French ↔ Italian  

French ↔ Portuguese 

French ↔ Dutch 

French ↔ Greek 

English ↔ Russian 

English ↔ Arabic 

English ↔ Simplified Chinese 

English ↔ Traditional Chinese 

 

 



 

Appendix C: Application Pack Installation 

Client Workstation Requirements 
Users of SYSTRAN Enterprise Global Server 5.0 must be working on client computers 
with the following specifications in order to install and run the Application Packs: 

• Windows XP (Home or Professional) or Windows 2000 workstation (Service 
Pack 4 and above) 

• Internet Explorer 5.0 and above 

• Microsoft Office installation* 

• Access to the corporate network 

• Administrator rights for Application Pack installation 

SYSTRAN Enterprise Global Server 5.0 Application Pack 
Options 
Two Application Packs are available: 

User Tools 

SYSTRAN User Tools 

SYSTRAN User Tools include the SYSTRAN Toolbar and SYSTRAN Clipboard 
Taskbar. 

• The SYSTRAN Toolbar is automatically displayed as a toolbar in Microsoft 
Word, Excel, PowerPoint, Outlook, and Internet Explorer, providing one point of 
access to powerful translation capability from inside these applications. 

• The SYSTRAN Clipboard Taskbar (SCT) lets you translate text from almost any 
Windows-based application not supported by the SYSTRAN Toolbar by cutting or 
copying text to the Windows Clipboard. SCT automatically translates the 
Clipboard text, which you can then paste into any Windows-based application. 

The SCT appears at the top of the PC screen, with a Windows-based 
application below it, allowing easy access to the translation capability of 
SYTRAN Enterprise Global Server 5.0. 

                                                           
* Necessary only for users requiring access to SYSTRAN Enterprise 5.0’s Microsoft Office Plugin Applications. Office 97, 2000, 

2003 and XP supported. Internet Explorer.5.0 or higher.  
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SYSTRAN Expert Tools 

SYSTRAN Expert Tools provide robust capability for planning, managing and 
completing translation projects, and for improving the quality of your results with each 
new project you complete. 

SYSTRAN Translation Project Manager (STPM) helps you work with, edit, and 
enhance your translations. You can define options, review terminology, use 
Translation Memory, and interact with the SYSTRAN Dictionary Manager to build 
and modify your translation dictionaries. Powerful tools are also built into this 
application to support your regression testing and QA efforts. 

SYSTRAN Dictionary Manager (SDM) lets you build, create, and maintain User 
Dictionaries (UDs), Translation Memories (TMs), and Normalization Dictionaries 
(NDs), which can be used to customize your translations to your unique 
terminology and requirements. 

SYSTRAN MultiTranslate Utility (SMTU) is designed for users who perform a 
large number of translations. Using SMTU, you can place documents into groups 
(or batches) and translate them in one operation. 

Upgrading from SYSTRAN Enterprise Global Server 4.0 Client 
Software 
The SYSTRAN Enterprise Global Server 5.0 software has been designed to maintain 
compatibility with SYSTRAN 4.0 Application Packs. You can therefore upgrade to 
SYSTRAN Enterprise Global Server 5.0 without immediately updating your other 
existing SYSTRAN client installations. 

Dictionaries and SYSTRAN Dictionary Manager 4.0 

When a dictionary is uploaded from SYSTRAN Dictionary Manager 4.0 to SYSTRAN 
Enterprise Global Server 5.0, it is converted to a version 5 dictionary on the server. 

After uploading the dictionary, you will need to mark the dictionary as Public using the 
Dictionary Administration page in the SYSTRAN Enterprise Global Server 5.0 Web 
interface. 

  The ability to use Non-public dictionaries is a new feature available in 
SYSTRAN Enterprise Global Server 5.0. If you are working with SYSTRAN 
Translation Project Manager (STPM) 4.0 and want to use a dictionary created in 
version 5, you must set the dictionary to Public in order to display it in STPM version 
4.0. 
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Installing SYSTRAN Enterprise Global Server Application Packs 
SYSTRAN Enterprise Global Server Application Packs can be downloaded from the 
Downloads Web page. 

1. Click Downloads on the SYSTRAN Enterprise Global Server 5.0 main page 
to display the Downloads page. 

 

2. Click on User Tools or Expert Tools to download an application package to 
your system. 

  Click Cancel at any time to terminate the installation. 

3. Select a language for the installer instructions and click OK. 

 

4. The installer will check your system and prepare the installation. Click Next 
to continue. 



54 User Interface Guide: SYSTRAN Online Tools and Application Packs 

 

 

5. You will need to accept the software license agreement in order to complete 
the installation. To do so, click I accept…, and then click Next. Otherwise, 
click Cancel to end the installation. 

 

6. Enter your customer information and click Next. 
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7. By default, the Application Packs are installed in the directory C:\Program 
Files\SYSTRAN\5.0\Clients\. To use the default location, click Next. You 
can change the installation location by clicking Change… 

 

8. In most cases, you should install the Complete product. Check with your 
Network Administrator before selecting Custom. To install the complete 
product, click Next. 
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If Custom install is selected, the installation program displays a dialog to select 
which components to install. 

9. Click Back to change any of your settings. Click Install to proceed. A 
Progress bar will show the status of the installation. 

 

10. When the installer confirms a successful installation, click Finish. 

11. The installer may require you to restart the computer. Click Yes to restart 
your computer. 
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12. After installation, during your first use of the SYSTRAN Application Packs, 
you will need to enter the network URL for the Translation Server.  

See Configuring SYSTRAN Web Server Application Pack. 

 

You can change the translation server URL by right clicking on the SYSTRAN Server 
icon  and choosing Connection. See SYSTRAN Desktop Server. 
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Configuring SYSTRAN Enterprise Global Server Application 
Packs 

SYSTRAN Desktop Server 

The SYSTRAN Desktop Server application is installed on your client PC to manage 
the interaction between the applications in the SYSTRAN Application Packs and the 
Translation Server. 

Client PC

SYSTRAN
Translation Server

`

SYSTRAN
Application Packs

SYSTRAN
Desktop 
Server

Corporate
Network

 

Right-click on the  icon to display the server configuration options dialog box. 

Use this dialog box to: 

• Configure the URL to access to a translation server. 

Connecting to a SYSTRAN Enterprise Global Server 5.02 and above 

 By default, the URL of the SYSTRAN Enterprise Global Server 5.0 is 

• http://server_name/systran/tws 
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Connecting to a SYSTRAN Enterprise Global Server 5.01 

By default, the URL of the SYSTRAN Enterprise Global Server 5.0 is 

• http://server_name/systran/tws.asmx 

 

Connecting to a SYSTRAN Enterprise Global Server 4.0 

By default, the URL of the SYSTRAN Enterprise Global Server 4.0 is 

• http://server_name/systran/sws.asmx 

 

Log in to a SYSTRAN Enterprise Global Server 5.0 

• Log in to the current Translation Server to use the Expert Tools. 

This login and password should correspond to the one defined on the Translation 
Server for managing dictionaries. See your Network Administrator. 

• Change the language of the user interface in the SYSTRAN Application Packs. 
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Uninstalling an Application Pack 
To uninstall SYSTRAN Enterprise Global Server Application Packs, you can either run 
the Uninstall option in the SYSTRAN Client 5.0 group in your Windows Start menu. 

The Application Packs can also be removed using the Add/Remove Programs function 
in the Windows Control Panel. 
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